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1 Introduction

NLOPredict is a program for assissting in the prediction and analysis of nonlinear optical
phenomena. The capabilities of the program have been well described elsewhere. [1] It
is the purpose of this document to provide additional information about the operation of
NLOPredict to both End Users and future developers. Proficiency with UCSF Chimera is
assumed. This document was written by Levi Haupert jlhaupert@purdue.edu; and was last
updated 25 May 2009.

2 Configuration Files

NLOPredict stores its state in a Python dictionary data structure. This data structure can
be pickled (stored as a persistent Python object) or stored in a plain text format. The pickled
storage method was used extensively in older versions of NLOPredict and has been preserved
in newer versions for backward compatibility. The plain text option is preferred since they
can be used by other programs to prepare or modify configuration files for NLOPredict.

Each line of the configuration text file contains a key/value pair separated by a comma.
All names are enclosed in single quotes. Arrays are enclosed in bracketts. Simple numeric
values and python boolean values are undecorated.

When NLOPredict imports a configuration file, the program’s state dictionary is updated
to any key-value pairs found in the configuration file. When writing a configuration file,
it is not neccessary to include all possible key-value pairs—only desired key-value pairs are
necessary (using all of the key-value pairs for every update can have annoying consequences).

3 Menu

3.1 File
3.1.1 Import

This submenu allows the import of configuration data into the current session of NLOPredict.
Either plain text session data files or pickled .cfg files may be imported.

3.1.2 Export

The Export submenu allows NLOPredict to produce various types of persistent data. The
Session Data commend produces a plain text file containing NLOPredict’s current state. The
Contour Matricies command produces a text file containing the values used to construct the
current contour plot. The Plot Image command produces a raster graphics file representation
of the plot currently displayed in the plot area of NLOPredict. The Tensors command
produces a text file containing the current values of the molecular tensor (3)) and select
values of the Jones tensor (x;) and the Cartesian tensor (y.) as well as the combination of



Euler angles that produced them. The .cfg command produces a file containing NLOPredict’s
pickled state information. This command has been added for legacy purposes only.

Programmer Note: It would be nice to have an automated method for re-importing
the exported tensor values from Export Tensors.

3.2 Plot
3.2.1 Single Molecule Mode

When checked, the Single Molecule Mode value directs NLOPredict to apply its tensor
information exactly once to the loaded molecule. It should be noted that this behavior
is only correct if both the loaded tensor and loaded molecule share a common coordinate
system. When not in single molecule mode, NLOPredict applies tensor information to every
amide chromophore it detects in the molecule, identified based on sequence assignment from
the pdb file. In this mode, NLOPredict determines the orientation of every chromophore
and performs a coherent addition to calculate the total tensors.

3.2.2 Total Signal

This command draws two bar plots in the plot window. The top bar graph shows the value of
each element of the 3@ tensor in the current molecular orientation. The bottom plot shows
the values of some values of . in the current orientation.

3.2.3 Secondary Structure

This command draws the plots described for Total Signal but shows separate contributions
from « helicies and [ sheets, based on designations within the pdb file. The Total Signal
plot is the sum of all contributions within the Secondary Structure plot. This command
functions identically to Total Signal when in Single Molecule Mode.

3.2.4 Contour Plot

The Contour Plot command directs NLOPredict to display contour plots of selected x; or
Y. tensor elements, or mathematical combinations thereof, as functions of the 6 and v Euler
angles.

3.3 View
3.3.1 Apply Current Orientation

This command zeroes the Euler angles at the current orientation of the molecule. It is
especially important when working with the contour plots and defining local coordinates
within a molecule. Changing any other parameters after applying the current orientation
will reset the Fuler angle zeroes to the original orientation. Changing the Euler angle



zeroes permanently requires exporting structures from UCSF Chimera and Tensors from
NLOPredict as new files.

Programmer Note: Loss of applied orientation after adjusting parameters, especially
tensor values, is a continued source of consternation for users. Should we find a way to better
preserve the applied orientation?

3.3.2 Reset Orientation

This command resets the molecular orientation in UCSF Chimera by returning all of the
Euler angles to zero. This command is executed automatically when any of NLOPredict’s
internal parameters are changed.

3.3.3 Alpha/mu visibility

This submenu provides several options for visualizing important tensors in Chimera. The
hidden value (obviously) suppresses visualization of the tensors. Direction draws sagittary
representations of ji (yellow vector) and the eigenvalues of v (green double arrows are positive
valued while red double arrows are negative valued). The magnitude setting is similar to
the Direction setting except that the relative values of the tensor components are considered
when drawing the arrows. The surface setting causes a hyperellipsoid representation of ﬁ(ZQ% 7
to be displayed. Red lobes show negative values and blue lobes show positive values.

3.3.4 Tensor Visual Scales

This command opens a dialog box which allows the visual representations of tensors in
Chimera to be scaled by arbitrary constants.

3.3.5 Tensor Surface Resolution

The dialog box invoked by this command provides control over how many points are used to
represent rotation through the spherical coordinates 6 and ¢ when drawing the hyperellipsoid.
Entering large values results in a smooth, but computationally expensive hyperellipsoid.
Non-integer resolution values will produce strange and startling effects.

3.4 Params
3.4.1 Multiplication Order

While in Full Beta mode, NLOPredict directly uses the values stored in the ‘full_beta’ line
of its configuration for 3?). Use this multiplication order if the system if the full molecular
tensor with 27 defined elements serves as the input. When in mu*alpha (SHG) or alpha*mu
(SFG) multiplication mode, the values stored in ‘mu_CO’ and ‘alpha_CO’ are multiplied to
create 3. This simplification is only valid near resonance. [2,3] Please note, however, that
the lineshape function is not applied to this multiplication in NLOPredict. Multiplication
by the lineshape function is still required to generate the complex-valued resonant tensor.
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3.4.2 Chi Equation

The d-function distribution is used for highly ordered systems while the weak orientation
limit is used for systems with broad distributions in the # Euler angle. The weak orientation
limit assums a uniform distribution in the ¢) and ¢ Euler angles. A more complete treatment
of the Weak Orientation Limit has been elucidated by Gualtieri et al. [4].

3.4.3 Tensors

The options in this submenu allow entry of arbritrary values for the /i, o, and 3®tensors.
Only real values are allowed.

3.4.4 Principal Atoms

This menu allows entry of arbitrary coordinates for the principal atoms of the amid chro-
mophore used when not in Single Molecule Mode.

3.4.5 Adjust Y-Limits

This command opens a dialog box for editing the minimum and maximum limits on the Total
Signal and Secondary Structure plots (e.g. When using confidence limits on experimental
observations).

3.4.6 Adjust Contour Plots

This command opens a dialog box allowing access to various contour plot parametaers. Most
importatnly, the Upper and Lower Plot entry fields allow selection of which y values will
be displayed. For xzz7 enter ‘ZZ7Z’ into the field. Allowed x’s are ZZZ, ZXX, XZX, XXZ,
XYZ, YZX, ZXY, ppp, PPS, PSP, Pss, spp, sps, and ssp. Python mathematical operators
may also be used. For instance ‘abs(ppp)**2” will plot the squared magnitude of x,,,.

3.4.7 Adjust Fresnel Factors

The Fresnel Factor editor allows editing of the three complex-valued Fresnel matrices, which
are used to calculate x;. Complex values can be entered using standerd Python syntax (e.g.
1+ 1j).

Programmer Note: Only the GUI aspect of the Fresnel Editor is currently implemented
and it accepts real and imaginary terms in separate entry fields. The editor needs to edit
the Fresnel matrices in the configuration in order to be effective. It would be convenient to
have the entry fields accept complex values.



4 Examples

4.1 o«o-Helix

In this example we will use NLOPredict to separate two exciton states in a typical a-
helix. [1] The first step will be getting the desired helix into Chimera for modeling. Enter
open pdbID:2d3e into the Chimera comand line to import a structure for Tropomyosin from
the PDB (connection to the internet is required). The structure is constructed from four
helices, but we only need one. Remove all but one of the helices using the command delete
:*.b:x.c:*x.d in the Chimera command line. Rotate the helix into a convenient coordinate
system by rotating the molecule in the Chimera window until the helix is orthogonal to the
plane of the computer display (long helix axis aligned with the Chimera’s Z-axis). Save
this orientation by entering write 0 file name into the command line. Close the current
session and open file_ name and make sure the helix is aligned to Chimera’s Z-axis.

Activate the NLOPredict plugin using Chimera’s Tool menu. NLOPredict is found under
Indiana/Purdue. Once NLOPredict is open, it needs to be configured to analyze the helix.
Under the Plot menu, make sure Single Molecule Mode is unchecked. Under the Params
menu, make sure the multiplication order is set to mu*alpha (SHG). Make sure the alpha/mu
visibility under the View menu is set to Surface. Now, import the provides alpha and mu
values for the Amide I vibration. Use the import session data command under the File menu
to open forPDBAmide_I.cfg.txt. The calculated 3Ptensor can be exported using export
tensors under the File menu in NLOPredict. Export the tensors.

Now it is time to visualize the 3@ tensors for the two exciton states. All of the molecular
tensor elements with z as their first index correspond with the A state. The remaining
elements correspond with the B state. Put NLOPredict in single molecule mode using the
option under the plot menu. Change the multiplication order under the Params menu to Full
Beta. Adjust the 3®®tensor using the Tensors option under the Params menu. To visualize
the A state, copy all the molecular tensor vales with z as the first index from the previously
exported molecular tensor into the f®®editor and make all other values zero. Applying this
tensor will visualize the A state. The B state can then be visualized by setting all of the
B@elements with z as the first index to zero and copying the rest of the tensor elements from
the previously exported tensor. The results should agree with those presented in J Comput
Chem 28: 1996-2002, 2007.

4.2 Thin Film

In this example, we will use NLOPredict to calculate possible orientations of molecules in a
thin film by comparing predictions with experimental measurements of the x; tensor. In this
exercise we will be revisiting the analysis previously performed by Begue et al. on disperse
yellow-7 (DY7) [5].

The first step in the process is importing the molecule and the configuration data into
USCF Chimera and NLOPredict. First, open the structure for planar DY7 (dy7.mol2) in
USCF Chimera and then open NLOPredict. Make sure NLOPredict is in Single Molecule



Mode and the multiplication order is set to Full Beta. Import the configuration file dy7beta_-
config.txt, which contains the quantum mechanically calculated 3Ptensor as well as cal-
culated Fresnel Factors for a thin film of DY7 on a glass slide.

We will use NLOPredicts contour plot feature to determine possible orientations of DY7
in the thin film using the experimentally measured ratios ]’;p—;p\ and \iﬁ”—p . Open the Con-

tour Plot parameter editor and set the upper plot to abs(ppp/sps) and the lower plot to
abs(pss/sps). Set the upper plot limits to 2.534 and 2.450 and set the lower plot limits to
1.32 and 1.24 and check the Set Limits box for both plots.

Now that the contour plots are configured, we must place the DY7 molecule and tensors
in a coordinate system consistent with the system presented by Begue et al. by rotating
the molecule in Chimera. The simples way to accomplish this is to set the Euler angles in
NLOPredict to 6 = 90, ¢ = 180, and ¢ = 90. Once the reorientation has been accomplished
apply the current orientation. Compare the generated contour plots to those presented by
Begue et al.—they should be the same.

In order to observe the orientations consistent with the predictions and the experimental
results, we need to find places where the upper and lower contour plot traces overlap. Clicking
the mouse with the cursor in one of the contour plots immediately shows that orientation in
Chimera and places a white dot in both plots. Click and drag the mouse in the upper plot
until one the white dot appears over an overlap region. USCF Chimera now displays one
orientation of DY7 in the thin film that is consistent with theory and experiment.

5 x; Tensor Calculation

The x; tensor is calculated in NLOPredict using the folowing equation:
J.F-Q-G.=x;

The J matrix is a 27 x 8 element matrix which converts Cartesian coordiantes into Jones
coordinates. The F matrix is a 27 x 27 element matrix which applies Fresnel factor effects.
The Fresnel matrix is stored in config files as three 9 element vectors that are multiplied
together internally to create the 27 x 27 element matrix. The Q is a 27 x 27 element matrix
which applies symmetry to 62, the column vector containing the 27 elements from 3. For
a C. system, the Q matrix will take appropriate combinations of 3®elements to recover
the tensor of the ensemble. The Q matrix may also be used apply the rotational symmetry
operations of crystals. If no transformations are needed, the Q matrix may be set to an
identity matrix.
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